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Important information

WARNING

l Failure to follow the installation instructions shipped with your SMART product could result in

personal injury and product damage which may not be covered by your warranty.

l Do not open or disassemble the SMART product. You risk electrical shock from the high

voltage inside the casing. Opening the casing also voids your warranty.

l Do not stand (or allow children to stand) on a chair to touch the surface of your SMART

product. Rather, mount the product at the appropriate height.

l To reduce the risk of fire or electric shock, do not expose the SMART product to rain or

moisture.

l If your SMART product requires replacement parts, make sure the service technician uses

replacement parts specified by SMART Technologies or parts with the same characteristics

as the original.

l Ensure that any cables extending across the floor to your SMART product are properly

bundled and marked to avoid a trip hazard.

l Do not insert objects inside the cabinet ventilation holes, because they could touch

dangerous voltage points and cause electric shock, fire or product damage which may not

be covered by your warranty.

l Do not place any heavy objects on the power cable. Damage to the cable could cause

shock, fire or product damage which may not be covered by your warranty.

l Use only extension cords and outlets into which this product’s polarized plug can be fully

inserted.

l Use the power cable provided with this product. If a power cable is not supplied with this

product, please contact your supplier. Use only power cables that match the AC voltage of

the power outlet and that comply with your country’s safety standards.

l If the glass is broken, do not touch the liquid crystal. To prevent injury, handle glass

fragments with care when disposing of them.

l Do not move or mount the interactive flat panel by connecting rope or wire to its handles.

Because the interactive flat panel is heavy, rope, wire or handle failure could lead to

personal injury.
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l Use only VESA®-approved mounting hardware.

l Disconnect all power cables for your interactive flat panel from the wall outlet and seek

assistance from qualified service personnel when any of the following occurs:

o The power cable or plug is damaged

o Liquid is spilled into the interactive flat panel

o Objects fall into the interactive flat panel

o The interactive flat panel is dropped

o Structural damage such as cracking occurs

o The interactive flat panel behaves unexpectedly when you follow operating

instructions

CAUTION

l Before you clean your SMART product, shut down or disconnect the computer. Otherwise,

youmay scramble the desktop icons or inadvertently activate applications when you wipe

the screen.

l Avoid setting up and using the SMART product in an area with excessive levels of dust,

humidity and smoke.

l Make sure an electrical socket is near your SMART product and remains easily accessible

during use.

l The external power supply needs to meet the Limited Power Source (LPS) requirements of

CSA/UL/IEC/EN 60950-1, when required.

l This SMART product should be used only with European TN and TT power distribution

systems.

It is not suitable for older, IT-type power distribution systems found in some European

countries. “This system (IT-type) is widely used isolated from earth, in some installations in

France, with impedance to earth, at 230/400V, and in Norway, with voltage limiter, neutral

not distributed, at 230V line-to-line.” (IEC 60950:1999)

Contact qualified personnel if you’re uncertain of the type of power system available where

you’re installing your SMART product.

l Youmust connect the USB cable that came with your interactive flat panel to a computer

that has a USB compliant interface and that bears the USB logo. In addition, the USB source

computer must be compliant with CSA/UL/EN 60950 and bear the CE mark and CSA and/or

UL Mark(s) for CSA/UL 60950. This is for operating safety and to avoid damage to the

interactive flat panel.
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IMPORTANT

l The following are the power requirements for your interactive flat panel:

Model Power requirements

SPNL-6055 90V to 240V AC, 50Hz to 60 Hz, 122 W

SPNL-6065 100V to 240V AC, 50 Hz to 60 Hz, 190W

l For additional requirements and other information, refer to your interactive flat panel’s

specifications (see Resources for decision makers on page 7).
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This chapter introduces you to your SMART Board® interactive flat panel and this guide.

About this guide
This guide explains how to set up and maintain your interactive flat panel. It includes the following

information:

l How to mount your interactive flat panel

l How to connect power and devices

l How to set up your interactive flat panel

l How to maintain your interactive flat panel for years of use

l How to troubleshoot issues with your interactive flat panel
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In addition, this guide includes information on your interactive flat panel’s on-screen display menu

and remote management support.

This guide is intended for individuals who are responsible for installing and maintaining interactive

flat panels in their organizations. Other documentation and resources are available for individuals

who use interactive flat panels.

About your interactive flat panel
Your SMART Board® interactive flat panel features SMART’s proprietary DViT®

(Digital Vision Touch) technology on an LCD screen with e-LED backlight.

Models
The SMART Board 6000 series interactive flat panels consists of two models:

l SMART Board 6055 interactive flat panel

l SMART Board 6065 interactive flat panel

Differences between these models are noted in this guide.

Features
Your interactive flat panel includes the following features:

Feature Description

Touch support You can do everything on your interactive flat panel that you can
do at your computer—open and close applications, meet with
others, create new documents or edit existing ones, visit websites,
play and manipulate videos, and so on—by touching the interactive
flat panel’s surface.

You can use an array of gestures within applications, including
panning, scaling, rotating and zooming in and out.

The interactive flat panel’s support for at least four simultaneous
touches enables you and other users to interact with objects on the
screen at the same time.

Writing and drawing
support

You can write over any application in digital ink using one of the
supplied pens, and then erase the digital ink using the eraser on the
pen or your palm.

You and another writer can write or draw digital ink on the screen at
the same time. The Pen ID feature enables you to assign different
ink appearances to each pen.

Audio support Your interactive flat panel includes integrated speakers for
presenting audio from connected input sources.
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Components
Your interactive flat panel consists of the following components:

No. Name More information

Pictured

1 Screen Page 3

2 Cameras and reflective tape channel Page 4

3 Front control panel Page 4

4 Pen with eraser (×2) Page 5

Not pictured

5 Speakers Page 5

6 Connector panel Page 13

7 Menu control panel Page 35

Screen
The screen specifications vary by model:

Models Diagonal Width Height Aspect ratio

SPNL-6055 54 1/2" (138.4 cm) 47 5/8" (121 cm) 26 3/4" (68 cm) 16:9

SPNL-6065 64 1/2" (163.9 cm) 56 1/4" (142.8 cm) 31 5/8" (80.4 cm) 16:9

For information on cleaning the screen, see Cleaning the screen on page 25.
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Cameras and reflective tape channel
In the corners of the screen, there are cameras that track finger and pen positions across the

screen. The screen is bordered by a channel that contains reflective tape.

For information on cleaning the camera windows and reflective tape, see Cleaning the screen on

page 25.

CAUTION

l Keep the reflective tape dry.

l Do not remove or damage the reflective tape.

IMPORTANT

l Do not attach items such as adhesive notes to the screen because they will interfere with

the cameras.

l Do not place anything in the channel because it will interfere with the cameras.

Front control panel
The front control panel contains the Standby, Input Select, Mute and volume control buttons.

No. Name

1 Standby button

2 Input Select button

3 Mute button

4 Volume decrease

5 Volume increase

IMPORTANT

If there is a film over the front control panel, remove the film before using the front control panel.

In normal operation, all buttons are white.
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The Standby button also functions as an indicator light:

Indicator light Interactive flat panel status Troubleshooting

Off Not receiving power Confirm the interactive flat panel’s power
cable is connected to the power outlet
(see page 14).

Flick the power switch to the ON (I)
position (see page 17).

Solid amber DPMS (power management)
mode

Press the Standby button to exit
DPMS mode.

Slowly flashing
amber

Standby mode Press the Standby button to exit
Standby mode.

Flashing amber No USB connection from the
connected computer

Verify your connections (see page 14).

Slowly flashing
white

SMART Board service not
running on the connected
computer

Ensure that SMART Product Drivers is
installed and that the SMART Board
service is running.

Solid white Normal operation [N/A]

Pens with erasers
Your interactive flat panel comes with two pens with erasers attached.

The bottom bezel of the interactive flat panel includes magnetic holders for the pens. Removing a

pen from the holders activates it and enables you to either draw or erase digital ink.

CAUTION

When returning the pen to the magnetic holder, ensure that it is centered in its holder to prevent

it from falling and potentially being damaged.

Speakers
Your interactive flat panel includes two 10 W integrated side firing speakers.

You can connect external speakers if desired (see Connecting external speakers on page 15).



CHAPTER1
WELCOME

6 smarttech.com/kb/170642

About SMART software
You can install the following SMART software on the computers connected to your interactive flat

panel to take full advantage of the interactive flat panel’s features:

Software Description

SMART Product Drivers SMART Product Drivers enables connected computers to detect
input from your interactive flat panel.

SMART Ink™ SMART Ink enables you to write and draw in digital ink over open
applications, files, folders, websites and any other open window on
your computer. When you write outside the open windows on your
computer, a SMART Ink Note appears and you can write inside the
note.

When you open an application that has its own ink tools, you can
turn off SMART Ink, and then use the application’s ink tools to write
in the content.

SMART Notebook®
collaborative learning
software

SMART Notebook software enables you to use your interactive flat
panel in a classroom.

Resources for administrators
In addition to this guide, there are other resources for administrators.

Training
The SMART training website (smarttech.com/training) includes an extensive library of training

resources you can refer to when learning how to set up and maintain your interactive flat panel.

Support center and knowledge base
The Support center (smarttech.com/support) contains a library of documents, including this guide,

and a knowledge base that you can search when troubleshooting issues.

http://www.smarttech.com/training
http://www.smarttech.com/support
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Resources for others
SMART provides resources for decision makers, installers and users as well as administrators.

Resources for decision makers
Decision makers can refer to the specifications for detailed information on the interactive flat

panels.

Interactive flat panel Specifications

SMART Board 6055 interactive flat panel smarttech.com/kb/170817

SMART Board 6065 interactive flat panel smarttech.com/kb/170640

Resources for installers
Installers can refer to the installation instructions included with your interactive flat panel when

installing the product. If installers have misplaced these installation instructions, they can download

a PDF version from smarttech.com/kb/170641.

Resources for users
Users can refer to the SMART Notebook software Help for information on using the software with

the interactive flat panel. To open the Help, users can select Help > Contents in the

SMART Notebook software window.

http://www.smarttech.com/kb/170817
http://www.smarttech.com/kb/170640
http://www.smarttech.com/kb/170641
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Chapter 2: Mounting your interactive flat panel

Before mounting your interactive flat panel 9
Choosing a location 10
Choosing a height 11

To mount your interactive flat panel on a wall, you require a team of professional installers.

This chapter is intended for installers. Installers should read this chapter along with the installation

instructions included with the interactive flat panel before they mount the interactive flat panel.

WARNING

Improper mounting of your interactive flat panel can result in personal injury and product

damage.

Before mounting your interactive flat panel
Do the following before mounting your interactive flat panel:

l Review the environmental requirements in the interactive flat panel’s specifications (see

Resources for decision makers on page 7).

l Save all product packaging so that it’s available if you need to transport the interactive flat

panel. If the original packaging isn’t available, you can purchase new product packaging from

your authorized SMART reseller (smarttech.com/where).

l Refer to local building codes to ensure the wall can support the weight of the interactive flat

panel specified in the following table and mounting equipment.

Model Weight

SPNL-6055 104 lb. (47.4 kg)

SPNL-6065 135 lb. 6 oz. (61.4 kg)

l Use a standard VESA 400 mm × 400 mm mounting plate (not included) to mount the

interactive flat panel on a wall.

http://smarttech.com/where
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l Use M8 screws to fasten the wall bracket.

Screw length 20 mm + xmm < M8 < 45 mm + x mm

where x is the total thickness of the wall bracket and washer

Fasten force 97.36–177.01 in-lb. (11–20 N·m)

CAUTION

Do not over-tighten the screws.

NOTE

SMART recommends M8 × 30 mm mounting screws for standard installations where the

total wall mount bracket and washer thickness is less than 7 mm.

l Because the receptacles might not be easily accessible after the installers mount the

interactive flat panel, consider connecting cables for power, computers and other devices

while the interactive flat panel is still in its packaging (see Connecting power and devices on

page 13).

l Before turning on the interactive flat panel for the first time, clean the camera windows and

reflective tape following the instructions in Cleaning the camera windows and reflective tape

on page 26.

Choosing a location
Do the following when choosing a location for the interactive flat panel:

l Do not install the interactive flat panel in a location where a door or gate could hit it.

l Do not install the interactive flat panel in an area where it will be subjected to strong vibrations

or dust.

l Choose a location that’s far from bright light sources, such as windows and strong overhead

lighting. IR lighting can cause issues with the performance of the cameras and can lead to

unintentional or missed touches.

l Do not install the interactive flat panel near where the main power supply enters the building.

l Ensure adequate ventilation or provide air conditioning around the interactive flat panel so

that heat can flow away from the unit and the mounting equipment.

l If you mount the interactive flat panel in a recessed area, leave at least 4" (10 cm) of space

between the interactive flat panel and the recessed walls to enable ventilation and cooling.
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Choosing a height
Consider the general height of the user community

when you choose the height for the interactive flat

panel.
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Chapter 3: Connecting power and devices
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Connecting power 14
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This chapter includes information on connecting your interactive flat panel to power, computers

and other devices.

Connector panel
The following diagram and table present the connectors on the interactive flat panel:

No. Connector Connects to Notes (if any)

1 RS-232 Room control system See page 39.

2 USBMicro-B [N/A] This connector is a service port.

3 Stereo 3.5 mm External speakers See page 15.

4 USB Type-B Room computer (data) See page 14.
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No. Connector Connects to Notes (if any)

5 HDMI® Room computer (video) The HDMI cable should be HDMI 1.4
compliant and no longer than 16' 5"
(5 m).

For more information, see below.

Connecting power
Connect the supplied power cable from the AC

power inlet on the bottom of the interactive flat panel

to a power outlet.

NOTE

Refer to your interactive flat panel’s specifications for power requirements and power

consumption information (see Resources for decision makers on page 7).

Connecting the
room computer
Using USB and HDMI cables, connect the room

computer to the appropriate connectors on the

interactive flat panel.

NOTES

l You can use the interactive flat panel with up to two USB-XT extenders.

l If you use a CAT 5 USB extender, the maximum length of the Cat 5 cable is 52' (16 m).

Press the Input Select button on the front control panel until the input source is HDMI.
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Connecting external
speakers
Your interactive flat panel includes two 10 W

speakers. However, you can connect external active

speakers using the stereo 3.5 mm connector.
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Chapter 4: Setting up your interactive flat panel
and the room computer
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This chapter explains how to set up your interactive flat panel and the room computer after

mounting your interactive flat panel and connecting power and devices.

Turning on your interactive flat panel and the
room computer for the first time
After connecting the room computer to the interactive flat panel (see Connecting the

room computer on page 14) and mounting the interactive flat panel (see Mounting your interactive

flat panel on page 9), you can turn on both devices.

To turn on your interactive flat panel and the room computer for the first time

1. Turn on the room computer.

2. Turn on your interactive flat panel by flicking the power switch beside the AC power inlet to

the ON (I) position.

3. Press the Standby button on the front control panel.
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Installing SMART software
To take full advantage of your interactive flat panel’s features, youmust download and install

SMART software on the room computer.

The purchase of your interactive flat panel includes a license for SMART Notebook software and a

one-year subscription to the SMART Notebook Advantage software maintenance plan. See

smarttech.com/notebook for more information.

TIP

You can also install SMART Notebook software from the DVD included with your interactive flat

panel.

To download and install SMART software

1. Go to smarttech.com/downloads.

2. Scroll to the SMART Notebook software section.

3. Click Choose a version, and then select the most recent version.

4. Click Download.

5. Follow the on-screen instructions to save the installer to a temporary location.

6. Double-click the installer.

7. Follow the on-screen instructions to install SMART software.

http://www.smarttech.com/notebook
http://www.smarttech.com/downloads
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Running the connection wizard
After turning on your interactive flat panel and the room computer for the first time and installing

SMART software, run the connection wizard to orient the interactive flat panel.

To run the connection wizard

1. Access the SMART ConnectionWizard by opening SMART Settings (see

Opening SMART Settings on page 22).

2. Press Connection Wizard.

The SMART ConnectionWizard appears.

3. Select the interactive flat panel from the list of connected SMART interactive products, and

then press Next.

4. Select Product is being set up for the first time, and then press Next.

5. Follow the on-screen instructions to orient the interactive flat panel for the first time.
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This chapter includes commonmaintenance procedures for your interactive flat panel.

Resetting your interactive flat panel
You can reset your interactive flat panel using the front control panel.

To reset your interactive flat panel

1. Press the Standby button on the front control panel.

A message appears on the screen, prompting you to either press the button again to enter

Standby mode or press and hold the button to reset the interactive flat panel.
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2. Press and hold the Standby button until the screen turns black.

The interactive flat panel resets and then your computer’s logon screen or desktop appears

on your interactive flat panel.

Maintaining your interactive flat panel software
and firmware
This section includes commonmaintenance procedures for your interactive flat panel software and

firmware.

Opening SMART Settings
Several maintenance and troubleshooting procedures in this guide require you to open

SMART Settings.

To open SMART Settings on Windows 7 operating system

Select Start > All Programs > SMART Technologies > SMART Tools > SMART Settings.

SMART Settings appears.

To open SMART Settings on Windows 8 operating system

1. Open the Apps screen.

2. Press SMART Settings.

SMART Settings appears.

To open SMART Settings on Mac OS operating system software

1. Press the SMART Board icon on the Mac menu bar.

2. Press SMART Settings.

SMART Settings appears.

Updating firmware
Your interactive flat panel uses firmware on its processor. You can update the firmware. For more

information, see Updating the firmware on your SMART Board 6065 interactive flat panel

(knowledgebase.force.com/?q=000015055).

http://knowledgebase.force.com/?q=000015055
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Updating software
SMART Product Update (SPU) is included in the SMART software you installed to use your

interactive flat panel (see Installing SMART software on page 18). SPU periodically checks for

updates to the SMART software posted on the SMART website. You can configure SPU to prompt

users to install updates or to install updates automatically.

NOTE

If you didn’t install SPU, you can download updates to SMART software from

smarttech.com/downloads.

Orienting your interactive flat panel
If the location of your touch is misinterpreted (the pointer appears a distance from the actual

contact), orient your interactive flat panel.

NOTE

You can use your finger or an interactive flat panel pen to orient your interactive flat panel.

To orient the interactive flat panel

1. Open SMART Settings (see Opening SMART Settings on the previous page).

2. Press Orient.

3. Press the red targets as they appear. Hold your finger or the tip of the pen at the center of

each target, and then lift the pen or finger. When you lift the pen or finger, the target moves to

the next orientation point.

IMPORTANT

Hold the pen perpendicular to the screen.

4. Continue until you’ve pressed all the targets.

The orientation window closes.

5. If this doesn’t correct inaccurate touch, calibrate your interactive flat panel (see Calibrating

your interactive flat panel on the next page).

http://www.smarttech.com/downloads
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Calibrating your interactive flat panel
Digital cameras in the corners of the interactive flat panel track the position of the pens, eraser and

your finger on the interactive surface, and then send the information to the SMART software, which

interprets this information as mouse clicks, digital ink or ink removal in the appropriate location.

Calibration determines the position and angles of the cameras to accurately identify the location of

touches on your interactive flat panel.

IMPORTANT

If an error message appears while you are calibrating your interactive flat panel, contact

SMART Support (smarttech.com/contactsupport).

To calibrate your interactive flat panel

1. Open SMART Settings (see Opening SMART Settings on page 22).

2. Press SMART Hardware Settings.

3. If you have more than one SMART product connected, select the interactive flat panel.

4. Select Advanced Settings from the drop-down list.

5. Press Calibrate.

The calibration screen appears. This can take a few moments.

6. Press the red target with the tip of an interactive flat panel pen. Hold the tip at the center of

the target until the target turns green, and then lift the pen.

The target moves to the next location.

NOTE

You can calibrate a target again by pressing the LEFT ARROW key on your keyboard.

7. Continue pressing targets until the second calibration screen and a grid appears.

An example appears briefly to demonstrate how to draw across the screen to calibrate the

interactive surface.

8. Use a pen to draw a spiral horizontally across the grid. As you draw, the ink is blue. As you

complete each square, the square becomes green.

9. When all the squares are green, a progress bar appears.

When the progress bar is full, the interactive flat panel displays the message

Calibration successful.

10. Orient your interactive flat panel (see Orienting your interactive flat panel on the previous

page).

http://www.smarttech.com/contactsupport
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Maintaining your interactive flat panel hardware
If you properly maintain your interactive flat panel hardware, it will provide years of use.

Checking the interactive flat panel installation
Inspect your interactive flat panel installation frequently to ensure that it remains securely installed.

l Check the mounting location for signs of damage or weakness that can occur over time.

l Check for loose screws, gaps, distortions or other issues that could occur with the mounting

apparatus.

If you find an issue, contact a professional installer.

Cleaning the screen
Follow these instructions to clean the interactive flat panel screen without damaging its anti-glare

coating or other product components.

CAUTION

l Do not use permanent or dry-erase markers on the screen. If dry-erase markers are used on

the screen, remove the ink as soon as possible with a lint-free, non-abrasive cloth.

l Do not rub the screen with a dense or roughmaterial.

l Do not apply pressure to the screen.

l Do not use cleaning solution or glass cleaner on the interactive flat panel screen, because

they can deteriorate or discolor the screen.

l Avoid touching the reflective tape between the screen and the bezel, and ensure that this

strip stays dry. Damage to this strip affects touch interactivity.

To clean the screen

1. Turn off the room computer.

2. Press the Standby button on the front control panel twice.

3. Flick the power switch beside the AC power inlet.

4. Wipe the screen with a lint-free, non-abrasive cloth.
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Cleaning the camera windows and reflective tape
The DViT technology in your interactive flat panel uses four cameras in the corners of the frame

and the reflective material between the screen and the bezels. Excessive dust buildup on the

camera windows or reflective tape can impair touch performance.

These areas should be inspected regularly for dust and should be cleaned if any obvious dust

buildup has occurred.

CAUTION

l Do not use compressed air to clean the camera windows or borders.

l Do not use water, chemicals or cleaning agents.

l Applying too much pressure when cleaning the tape or cameras can damage the tape and

cause performance issues or errors.

To clean the camera windows and reflective tape

1. With a clean lint-free cloth, gently wipe the camera windows in the top corners and the

reflective tape along the top of your interactive flat panel screen using the cloth.

2. Gently wipe the reflective tape along the sides of your interactive flat panel screen.

3. Gently wipe the camera windows in the bottom corners and the reflective strip across the

bottom of your interactive flat panel screen.

Maintaining ventilation
Your interactive flat panel requires ventilation to function. Dust buildup in the ventilation holes

compromises cooling and leads to product failure.

l Clean accessible ventilation holes monthly with a dry cloth.

l Use a vacuum cleaner with a narrow hose end fitting to clear the back ventilation holes

regularly. Youmight have to remove the interactive flat panel from your wall. For more

information on removing your interactive flat panel see Removing your interactive flat panel

on the next page.

CAUTION

Avoid setting up or using your interactive flat panel in an area with excessive levels of dust,

humidity or smoke.
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Preventing condensation
Your interactive flat panel screen contains layers of glass that can collect condensation, especially

in the following conditions:

l Temperature extremes with high humidity

l Rapid changes in humidity, which can occur when you operate the product near water, such as

a pool, kettle or air conditioner ventilator

l Direct exposure to sunlight

To evaporate condensation from your interactive flat panel

1. Remove the humidity source from the interactive flat panel, if possible.

2. Turn off the interactive flat panel.

3. Remove any moisture from the interactive flat panel with a smooth, dry cloth.

4. Leave the interactive flat panel turned off for 48 hours.

Maintaining pens
To prevent damage to your interactive flat panels’ anti-glare coating, replace a pen if its nib

becomes worn. You can purchase replacement pens from the Store for SMART Parts

(see smarttech.com/Support/PartsStore).

Removing and transporting your
interactive flat panel
On occasion, youmight need to remove your interactive flat panel from its current location and

transport it to another location.

Removing your interactive flat panel
To safely remove your interactive flat panel, use two or more professional installers.

WARNING

l Do not attempt to move the interactive flat panel using your own strength. The interactive

flat panel is very heavy.

l Do not move the interactive flat panel by connecting a rope or wire to the handles on the

back. The interactive flat panel can fall and cause personal injury and product damage.

http://www.smarttech.com/Support/PartsStore
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IMPORTANT

Follow the instructions included with the floor stand or mounting apparatus.

To remove your interactive flat panel

1. Turn off the room computer.

2. Press the Standby button on the front control panel twice.

3. Flick the power switch beside the AC power inlet.

4. Remove all accessible cables and connectors.

5. Lift your interactive flat panel from its mounting location.

WARNING

Do not place the interactive flat panel on a sloping or unstable cart, stand or table, because

the interactive flat panel could fall, resulting in injury and severe product damage.

CAUTION

Do not leave the interactive flat panel face up, face down or upside down for an extended

period of time, because it could cause permanent damage to the screen.

6. Remove the mounting brackets.

Transporting your interactive flat panel
Save your original packaging so that you can repack your interactive flat panel with as much of the

original packaging as possible. This packaging was designed with optimal shock and vibration

protection. If your original packaging isn’t available, you can purchase the same packaging directly

from your authorized SMART reseller (smarttech.com/where).

CAUTION

Transport your interactive flat panel only in original or replaced packaging. Transporting your

interactive flat panel without correct packaging voids your warranty and could lead to product

damage.

http://www.smarttech.com/where
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Chapter 6: Troubleshooting
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This chapter provides you with the information necessary to solve simple issues that can occur with

your interactive flat panel. If issues persist, or aren’t covered in this chapter, contact

SMART Support (smarttech.com/contactsupport).

Locating the interactive flat panel serial number
When you contact SMART Support, you might be asked to provide the interactive flat panel

serial number. The serial number is located in two places:

l The on-screen display menu (see Serial Number on page 38)

l Underneath the bottom bezel

Resolving common issues using the indicator light
The Standby button on the front control panel also functions as an indicator light. You can use the

indicator light to resolve common issues with the interactive flat panel. For more information, see

Front control panel on page 4.

http://www.smarttech.com/contactsupport
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Resolving image issues
Use the following table to resolve image issues:

Symptom Cause Solution

The image is too light, too darkor
has poor image quality.

Your interactive flat panel’s picture
settingsmight be set incorrectly.

Adjust the Picture options (see Picture on
page 36).

There is a persistent image on the
screen.

An imagewas displayed for too
long.

l Turn off your interactive flat panel and
leave it turned off for as long as the image
was on the screen.

l Set up screen savers on any connected
computers to prevent persistent images.

There are other image issues. Return all on-screen displaymenu
settings to their default values (see
page 38).

Resolving touch issues
Use the following table to resolve touch issues:

Symptom Cause Solution

When you touch the screen, the
pointer appears in thewrong
location.

You aren’t touching the screen at a
right angle.

For more information, see Touching and
drawing on your SMARTBoard interactive
whiteboard is inaccurate
(knowledgebase.force.com/
?q=000013976).

Your interactive flat panel isn’t
oriented.

Orient your interactive flat panel (see
page 23.)

An area of the screen doesn’t
respond to your touch or when you
draw digital ink, the lines are
broken.

Something is blocking the cameras. Ensure nothing is taped to the screen.

Something is on the reflective tape
channel.

Remove items from the reflective tape
channel.

Your finger or pen is skipping as
you draw.This is most common on
the upstroke.

Use consistent pressure while drawing
digital ink.

Bright lights are interferingwith the
cameras.

Close blinds or shades or dim all halogen
lights and LEDs.

Your cameras require calibration,
possibly because of a temperature
change in the room.

Calibrate your interactive flat panel (see
page 24).

http://knowledgebase.force.com/?q=000013976
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Resolving connected computer issues
Use the following table to resolve connected computer issues:

Symptom Cause Solution

The connected computer’s display
is too large, too small or doesn’t
completely fill the screen.

The connected computer’s video
resolution settings don’t match
your interactive flat panel’s native
resolution.

l The native resolution is 3840 × 2160 at
30 Hz.

l If the connected computer can’t support
the above resolution, consider
1920 × 1080 at 60 Hz as an alternative.

The connected computer’s screen
resolution is correct, but the image
is surrounded by blackbars.

The connected computer’s video
card is underscanning the image.

l Turn off or adjust the
overscan/underscan feature in the video
card driver software until the image fits
the screen resolution.Refer to the
computer’s video cardHelp for more
information.

l Select the 4KUHDoption from the video
card driver’s advancedmenu (if available).
This should provide a pixel-perfect image
for your interactive flat panel.

You have a poor quality video
cable.

Replace the video cable with a better
quality video cable.

You connected two video cables
together.

l Replace your two cables with one longer
cable.
OR

l Move the computer so that it’s within a
single cable length of your interactive flat
panel.

The interactive flat panel’s native
resolution doesn’t match the
resolution on the computer’s
display adapter.

Check the resolution on the computer’s
display adapter and change your
interactive flat panel’s resolution tomatch.

The connected computer’s display
is unstable or unfocused.

The video connection is loose. Secure the video cable to both the
computer and your interactive flat panel.

You have a poor quality video
cable.

Replace the video cable with a better
quality video cable.

You connected two video cables
together.

l Replace your two cables with one longer
cable.
OR

l Move the computer so that it’s within a
single cable length of your interactive flat
panel.

The connected computer’s video
display card is defective.

Connect a different computer to your
interactive flat panel. If this improves the
image quality, consider replacing the
video card in the original computer.
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Symptom Cause Solution

The SMART Board icon doesn’t
appear.

SMART Product Drivers isn’t
installed.

Download and install
SMART Product Drivers from
smarttech.com/downloads.

SMART Product Drivers isn’t
running.

Start SMART Product Drivers following the
steps in the Help.

Touch interactivity is slow. The connected computer is
running toomany applications.

Close some open applications.

The connected computer doesn’t
meet SMART requirements.

Upgrade the computer or replace it with
another computer thatmeets system
requirements.

You haven’t used a USB 2.0 cable
to connect your interactive flat
panel to the computer.

Use a USB 2.0 cable and ensure it’s
connected to the correct USB receptacle
(see page 14).

Sound doesn’t playwhen you play
an audio file.

The connected computer’s
playbackdevice isn’t set correctly

Ensure the connected computer’s
playbackdevice is set as the interactive
flat panel (see the connected computer’s
documentation).

The interactive flat panel’s audio
input isn’t set correctly.

Ensure the interactive flat panel’s audio
input is set as the computer’s audio
connector (see page 37).

The connected computer is muted. Turn off themute setting.

The connected computer’s volume
is too low.

Turn up the volume on the computer.

Your interactive flat panel is muted. Turn off themute setting using the front
control panel.

Your interactive flat panel’s volume
is too low.

Turn the volume up using the front control
panel.

Using the SMART Connection Wizard
You can resolve a variety of issues using the SMART ConnectionWizard found in SMART Settings.

To use the SMART Connection Wizard

1. Access the SMART ConnectionWizard by opening SMART Settings (see

Opening SMART Settings on page 22).

2. Press Connection Wizard.

The SMART ConnectionWizard appears.

3. Select your interactive flat panel from the list of connected SMART interactive products, and

then press Next.

http://www.smarttech.com/downloads
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4. Select the option that best describes the issue you’re encountering, and follow the on-screen

instructions to troubleshoot your interactive flat panel.

Using SMART Board Diagnostics
If you touch the interactive flat panel’s surface and nothing happens, or if there is no digital ink or

the ink appears in some locations and not in others, use SMART Board Diagnostics to help identify

and resolve these issues.

IMPORTANT

Do not change diagnostic settings unless asked to do so by SMART Support.

To check camera views

1. Open SMART Settings (see Opening SMART Settings on page 22).

2. Select About Software and Product Support > Tools > Diagnostics.

SMART Board Diagnostics opens.

3. Select View > SPNL-6000/SBID8000-G5 Bar.

The group box appears.

4. Press View.

The camera view screen appears.

5. Click Get image to display the four camera views. This could take a few moments.

If one of the camera views doesn’t appear, the camera is blocked or can’t locate the

reflective tape on the interactive flat panel’s inner frame.

NOTE

You can compare the camera view to examples of normal camera views.

6. Check the camera lens and ensure that nothing is blocking its view and that nothing is affixed

to the interactive surface.
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Appendix A: Using the on-screen display menu

Changing settings in the on-screen display menu 35
On-screen display menu options 36

You can access the on-screen display menu using the menu control panel located on the side of

the interactive flat panel.

No. Name

1 MENU

2 SET

3 [Up]

4 [Down]

5 [Left]

6 [Right]

Changing settings in the on-screen display menu

To change settings in the on-screen display menu

1. Press the MENU button on the menu control panel.

The on-screen display menu appears.

2. Press the up and down arrows to highlight a menu, and then press SET.

3. Press the up and down arrows to highlight a menu option.
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4. Press the left and right arrows to change the menu option’s setting.

OR

Press the right arrow to open the menu option’s submenu. (Repeat steps 3 and 4 to change

settings in the submenu.)

5. Press MENU until the on-screenmenu closes.

On-screen display menu options
Option Values Function Notes (if any)

Picture

PictureMode Standard

User

Dynamic

Sets the picturemode Select User to customize
brightness, contrast, sharpness
and other Picture options.

Select one of this option’s other
values to set brightness, contrast,
sharpness and other Picture
options to default values.

Brightness 0–100 Sets the overall brightness of the
image and background

You canmodify this option only if
you select User in PictureMode.

Contrast 0–100 Sets the brightness of the image in
relation to the background

You canmodify this option only if
you select User in PictureMode.

BlackLevel 0–100 Sets the level of brightness in the
darkest parts of the image

You canmodify this option only if
you select User in PictureMode.

Color 0–100 Sets the image color depth You canmodify this option only if
you select User in PictureMode.

Sharpness 0–100 Sets the image sharpness You canmodify this option only if
you select User in PictureMode.

Color temperature Normal

Warm

User

Cool

Sets the color temperature Select User to customize the
amount of red, green and blue in
the image.

Select one of this option’s other
values to set the amount of red,
green and blue in the image to
default values.

Red 0–100 Sets the amount of red in the
image

You canmodify this option only if
you select User in Color
Temperature.

Green 0–100 Sets the amount of green in the
image

You canmodify this option only if
you select User in Color
Temperature.

Blue 0–100 Sets the amount of blue in the
image

You canmodify this option only if
you select User in Color
Temperature.
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Option Values Function Notes (if any)

MovieMode Off

Low

Middle

High

Sets the brightness, contrast, black
level, color and sharpness for
movie watching

Picture Reset [N/A] Resets all options in the Picture
menu to their default values

Sound

SoundMode

Treble L50–R50 Sets the high frequency sound

Bass L50–R50 Sets the low frequency sound

EQ

120 Hz 0–100 Sets the sound equalization at
120 Hz

500 Hz 0–100 Sets the sound equalization at
500 Hz

1.2 kHz 0–100 Sets the sound equalization at
1.5 kHz

7.5 kHz 0–100 Sets the sound equalization at
5 kHz

12 kHz 0–100 Sets the sound equalization at
10 kHz

Balance L50–R50 Balances the left and right volume

Audio Input HDMI

USB

Sets the audio input source

SoundReset [N/A] Resets all options in the Sound
menu to their default values

OSD

Language [Languages] Sets the on-screen displaymenu’s
language

OSDTurn Off Off

5 seconds

10 seconds

15 seconds

Sets the time of inactivity before the
on-screen displaymenu turns off
(in seconds)

OSDReset [N/A] Resets all options in theOSD menu
to their default values
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Option Values Function Notes (if any)

Setup

Power Save On

Off

Enables or disables Power Save
mode

When Power Savemode is enabled
and there isn’t video input, the
interactive flat panel displays
No Signal for 25 seconds before
turning off.

Setup Reset [N/A] Restores the setup settings to their
default value

Factory Reset [N/A] Resets options in allmenus to their
default values

About

ModelNumber [N/A] Displays the interactive flat panel’s
model number

This option only provides
information.You’re unable to
modify it.

SerialNumber [N/A] Displays the interactive flat panel’s
serial number

This option only provides
information.You’re unable to
modify it.

Scalar firmware version [N/A] Displays the interactive flat panel’s
scalar firmware version

This option only provides
information.You’re unable to
modify it.

Touch firmware version [N/A] Displays the interactive flat panel’s
touch firmware version

This option only provides
information.You’re unable to
modify it.

OPS Information [N/A] Displays whether theOPS is
installed

This option only provides
information.You’re unable to
modify it.
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This appendix includes detailed instructions on how to set up your computer or room control

system to remotely manage your interactive flat panel using an RS-232 serial interface.

Connecting and configuring a
room control system
Connect a computer to the room control input on the interactive flat panel to remotely select video

inputs, turn on or turn off the interactive flat panel and request information such as contrast, power

state and current settings.
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Connecting a computer to an interactive flat panel

To connect a computer to the interactive flat panel

Connect an RS-232 cable from the serial output on the computer to the room control input on

the connector panel.

IMPORTANT

Do not use a null modem cable. Use only a standard RS-232 cable.

Configuring the computer’s serial interface settings
You need to configure the computer’s serial interface before sending commands.

To configure the computer’s serial interface

1. Turn on the interactive flat panel.

2. Turn on the computer, and then start the serial communications program or terminal emulation

program.

3. Activate local echo.

4. Configure the serial interface settings using the following values, and then press ENTER.

Baud rate 19200

Data length 8

Parity bit None

Stop bit 1

A command prompt (>) appears on the following line.

NOTE

If no message appears or an error message appears, the serial interface configuration isn’t

correct. Repeat steps 3 and 4.

5. Type commands to configure the interactive flat panel.
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Power modes
An interactive flat panel has three distinct power modes:

l On

l Power Save

l Standby

All commands are available when the interactive flat panel is on. Some commands are available

when the interactive flat panel is in Standby mode.

Room control system programming commands
and responses
To access interactive flat panel information or to adjust interactive flat panel settings using the

room control system, type commands after the command prompt (>), and then wait for the

response from the interactive flat panel.

CORRECT

>get contrast
contrast=55

If you type a command that the room control system doesn’t recognize, you receive an invalid

command response.

In the example below the user included a space in the contrast command.

INCORRECT

>set con trast=65
invalid cmd=set con trast=65

NOTES

l Use ASCII formatted commands.

l Commands aren’t case-sensitive.

l Review each entry carefully before you press ENTER.

l Don’t send another command until you receive the response and the next command

prompt.
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Command inventory
The interactive flat panel responds to the commands in the tables on the following pages.

Viewing a list of available commands
You can view a list of available commands by typing ? at the command prompt.

Identifying current values
You can identify the current value for each setting. In the example below, the user wants to identify

the contrast level for the interactive flat panel.

>get contrast
contrast=55

Assigning a specific value
You can assign a specific value for a setting within the command’s target range. In the example

below, the user wants to set the contrast level for the interactive flat panel to 65.

>set contrast=65
contrast=65

Increasing a value for a setting
You can increase a setting by a designated number. In the example below, the user wants to

increase the contrast level for the interactive flat panel by 5.

>set contrast +5
contrast=70

Decreasing a value for a setting
You can decrease a setting by a designated number. In the example below, the user wants to

decrease the contrast level for the interactive flat panel by 15.

>set contrast -15
contrast=55

Designating video control settings for a specific video input
When you connect multiple video inputs to the interactive flat panel, you can designate different

settings for each video input. You can also specify which video input you want to get information

about or assign values to.

NOTE

Youmust connect the video input to the interactive flat panel to identify or assign a value for it,

but the video input doesn’t need to be in use.
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Identifying the value for a video control setting
Use the get command to identify values for a video control setting. In the example below, the user

wants to identify the contrast for the HDMI1 video input.

>get contrast hdmi1
contrast hdmi1=65

Assigning a value for a video control setting
Use the set command to assign values for a video control setting. In the example below, the user

wants to set the contrast to 70 for the HDMI1 video input.

>set contrast hdmi1=70
contrast hdmi1=70

Commands
The following tables contain commands for your interactive flat panel.

Power state
Use the following commands to identify power state settings.

Command Response Possible values Standby
mode

get intpowerstate intpowerstate=[Value] l on
l standby
l dpms
l novideo
l confirm
l proximitywait
l welcome

Yes

get powerstate powerstate=[Value] l on
l off
l standby

Yes

Use the following commands to assign power state settings.

Command Possible values Response Standby
mode

set powerstate [Value] l =on
l =off
l =standby

powerstate=[Value] Yes
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Source
Use the following commands to identify source settings.

Command Response Possible values Standby
mode

get input input=[Value] l hdmi1
l ops/hdmi2
l displayport

Yes

get videoinputs videoinputs=[Value] hdmi1,ops/hdmi2,displayport Yes

Use the following commands to assign source settings.

Command Possible values Response Standby
mode

set input [Value] l =hdmi1
l =ops/hdmi2
l =displayport
l =next

input=[Value] Yes

Video control
Use the following commands to identify video control settings.

Command Response Possible values Standby
mode

get displaymode displaymode=[Value] l standard
l user
l dynamic

No

get contrast contrast=[Value] 0–100 No

get brightness brightness=[Value] 0–100 No

get tint tint=[Value] 0–100 No

get sharpness sharpness=[Value] 0–100 No

get colortemp colortemp=[Value] l normal
l warm
l cool
l user

No

get red red=[Value] 0–100 No

get green green=[Value] 0–100 No

get blue blue=[Value] 0–100 No

get blacklevel blacklevel=[Value] 0–100 No
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Use the following commands to assign video control settings.

Command Possible values Response Standby
mode

set displaymode [Value] l =standard
l =user
l =dynamic

displaymode=[Value] No

set contrast [Value] l + [Incremental value]
l - [Incremental value]
l =0–100

contrast=[Value] No

set brightness [Value] l + [Incremental value]
l - [Incremental value]
l =0–100

brightness=[Value] No

set tint [Value] l + [Incremental value]
l - [Incremental value]
l =0–100

tint=[Value] No

set sharpness [Value] l + [Incremental value]
l - [Incremental value]
l =0–100

sharpness=[Value] No

set colortemp [Value] l =normal
l =warm
l =cool
l =user

colortemp=[Value] No

set red [Value] l + [Incremental value]
l - [Incremental value]
l =0–100

red=[Value] No

set green [Value] l + [Incremental value]
l - [Incremental value]
l =0–100

green=[Value] No

set blue [Value] l + [Incremental value]
l - [Incremental value]
l =0–100

blue=[Value] No

set blacklevel [Value] l + [Incremental value]
l - [Incremental value]
l =0–100

blacklevel=[Value] No

set picturereset [Value] =yes picturereset=[Value] No

Audio control
Use the following commands to identify audio control settings.

Command Response Possible values Standby
mode

get volume volume=[Value] 0–100 No

getmute mute=[Value] l on
l off

No
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Command Response Possible values Standby
mode

get audioinput audioinput=[Value] l usbaudio
l HDMI
l DisplayPort
l OPSdigital

No

get treble treble=[Value] 0–100 No

get bass bass=[Value] 0–100 No

get audioeq120 audioeq120=[Value] 0–100 No

get audioeq500 audioeq500=[Value] 0–100 No

get audioeq1200 audioeq1200=[Value] 0–100 No

get audioeq7500 audioeq7500=[Value] 0–100 No

get audioeq12k audioeq12k=[Value] 0–100 No

get balance balance=[Value] 0–100 No

Use the following commands to assign audio control settings.

Command Possible values Response Standby
mode

set volume [Value] l + [Incremental value]
l - [Incremental value]
l =0–100

volume=[Value] No

setmute [Value] l =on
l =off

mute=[Value] No

set audioinput [Value] l =usbaudio
l =HDMI
l =DisplayPort
l =OPSDigital

audioinput=[Value] No

set treble [Value] l + [Incremental value]
l - [Incremental value]
l =0–100

treble=[Value] No

set bass [Value] l + [Incremental value]
l - [Incremental value]
l =0–100

bass=[Value] No

set audioeq120 [Value] =0–100 audioeq120=[Value] No

set audioeq500 [Value] =0–100 audioeq500=[Value] No

set audioeq1200 [Value] =0–100 audioeq1200=[Value] No

set audioeq7500 [Value] =0–100 audioeq7500=[Value] No

set audioeq12k [Value] =0–100 audioeq12k=[Value] No

set balance [Value] l + [Incremental value]
l - [Incremental value]
l =0–100

balance=[Value] No

set soundreset [Value] =yes soundreset=[Value] No



APPENDIX B
REMOTELY MANAGING YOUR INTERACTIVE FLAT PANEL

47 smarttech.com/kb/170642

System information
Use the following commands to identify system information settings.

Command Response Possible values Standby
mode

get fwverscr fwverscr=[Value] [Scaler version firmware
number]

Yes

get fwvertouch fwvertouch=[Value] [Touch controller firmware
version number]

Yes

get serialtouch serialtouch=[Value] [Touch controller serial
number]

get opsinfo opsinfo=[Value] l OPS
l NOOPS

get language language=[Value] l English
l Arabic
l Danish
l German
l Spanish
l Finnish
l French
l Hebrew
l Italian
l Dutch
l Norwegian
l Portuguese
l Russian
l Swedish
l Turkish
l Chinese_sim

No

getmodelnum modelnum=[Value] [Model number] No

get serialnum serialnum=[Value] [Serial number] No

get proximityinstalled proximityinstalled=[Value] l yes
l no

getmonitorid monitorid=[Value] 1–100 No
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Use the following commands to assign system information settings.

Command Possible values Response Standby
mode

set factoryreset [Value] =yes factoryreset=[Value] Yes

set language [Value] l =English
l =Arabic
l =Danish
l =German
l =Spanish
l =Finnish
l =French
l =Hebrew
l =Italian
l =Dutch
l =Norwegian
l =Portuguese
l =Russian
l =Swedish
l =Turkish
l =Chinese_sim

language=[Value] No

setmonitorid [Value] l + [Incremental value]
l - [Incremental value]
l =1–100

monitorid=[Value] No

set touchdetected [Value] l =yes touchdetected=[Value]
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Appendix C: Hardware environmental
compliance

SMART Technologies supports global efforts to ensure that electronic equipment is manufactured,

sold and disposed of in a safe and environmentally friendly manner.

Waste Electrical and Electronic Equipment (WEEE)
Electrical and electronic equipment contain substances that can be harmful to the

environment and to human health. The crossed-out wheeled bin symbol indicates that

products should be disposed of in the appropriate recycling stream and not as regular

waste.

More information
See smarttech.com/compliance for more information.

http://www.smarttech.com/compliance
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A

air conditioning 10, 27
aspect ratio 3
audio

about 2
configuring 37, 45
controlling volume 4
muting 4
troubleshooting 32

B

balance, audio 37, 46
bass 37, 46
batteries 49
black level 36, 44
brightness 36, 44

C

calibration 19, 23-24, See also orientation
cameras

about 4
cleaning 26

chemicals 26
cleaning

camera windows 26
reflective tape 26
screen 25

color temperature 44
computer

connecting 14
condensation 27
connection wizard 19
connector panel 13

contrast 36, 44
control panels

front See front control panel
menu See menu control panel

D

DisplayPort 44
documentation 7
doors 10
dry-erase markers 25
dust 10, 26

E

ECO Standby mode 41
eraser 5

F

factory reset 38
firmware updates 22
front control panel

about 4

G

gates 10
gestures 2
glass cleaner 25

H

hardware installation 9, 25
hardware removal 27
HDMI 14, 44
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height for mounting your interactive flat

panel 11
humidity 26-27

I

installation
hardware See hardware installation
software See software installation

installation instructions 7

K

knowledge base 6

L

languages 37, 47
local building codes 9
location for mounting your interactive flat

panel 10

M

M8 screws 10
maintenance 21
markers 25
menu control panel 35
mounting instructions 9
multitouch capabilities 2
multiuser sketch support 2
mute See audio

O

object awareness 2
on-screen display menu 35
orientation 19, 23-24, See also calibration

P

packaging 28

Pen ID 2
pens

about 5
maintaining 27

permanent markers 25
power 10, 14, 17, 41, 43
presence detection sensors

configuring 47

R

recessed areas 10
reflective tape channel 4, 26
remote management 39
reset 21
room control 39
RS-232 39

S

serial number 47
serial numbers 29, 38
sharpness 36, 44
SMART Ink

about 6
installing 18
updating 23

SMART Notebook software
about 6
installing 18
updating 23

SMART Product Drivers
about 6
installing 18
updating 23

SMART Product Update 23
SMART Settings 22
smoke 26
software installation 18
software updates 23
sound See audio
speakers

external 15



INDEX

53 smarttech.com/kb/170642

included with your interactive flat

panel 2, 5, 45
specifications 7
stand 28
Standby mode 38, 41, 43
sunlight 27
Support center 6
system administrator’s guides 7

T

tint 44
training 6
transportation 28
treble 37, 46

U

updates
firmware 22
software 23

USB cables and connectors 14

V

vacuum cleaners 26
ventilation 10, 26
VESA mounting plate 9
vibrations 10
volume See audio

W

wall mounting instructions See mounting

instructions
water 26
WEEE Directives 49
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